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StoryO 3 Quick Start Guide

Stor

About StoryO

StoryO is outlining software for writers. Whether you are outlining a screenplay, a novel, a
short story, an academic report, a graphic novel, or any project that requires a timeline
and index cards, StoryO is for you.

Creating a New Project

After you launch StoryO, you will see 5 sample projects in the Projects screen.
To sample a project, click on the name of the project.

To create a new project, click on the plus button on the bottom left hand side of the screen.
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@ StoryO File Edit Format Spelling Extras Help
‘e0e@ Projects

Storys @
@ Time Travel "

Short Story

This is a sample project file to show how the Timeline works.

E It's a Wonderful Life

Screenplay
After George Bailey (James Stewart) wishes he had never been born, an
angel (Henry Travers) is sent to earth to make George's wish come true.

George starts to realize how many lives he has changed and impacted, and
how they would be different if he was never there.

$ Shakespeare’s Hamlet
Stage Play
The play, set in Denmark, recounts how Prince Hamlet exacts revenge on his

uncle Claudius, who has murdered Hamlet's father, the King, and then taken
the throne and married Gertrude, Hamlet's mother.

g The Civil War

Historical Timeline
A history of the Civil War fom 1821 to 1865

lick:here to,create,a new project.
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You will be prompted to enter a name for your project, along with a format.
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¢ Story Enter.a name for.you project...
X p—— ——— S A D s

f | n

s 8 sample® Project Title/Episode | My New Project

Episode Number
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. Select Format
It's a Wonderf
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Next, you will be prompted to enter how many Segments, Sequences, and Index Cards you
want to start with. You can always add or remove any of these later.

Enter/Acts, Scenes, Cards here then

create x‘yfourfTimeIine. ..

StoryO can auto-create a default Timeline with Segments (as Acts)
and Sequences (as Scenes).

How many Acts and Scenes would you like to create?

Acts
Scenes per Act 3
Index Cards per Scene 4
Auto-Create Timeline Manually Create Timeline

StoryO will create your Timeline.
The Timeline

On the bottom left you will see your Segments (top level hierarchy), in this sample the
Segments are: Acts.
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On the main Timeline canvas, you will see your Sequences, in this sample the Sequences are:
Scenes.

@& StoryO File Timeline Edit Format Extras Help @ —[&-@ @ S O 3 @ F « 9% Thul2:
[ JOX ) Timeline
< My New Project This/is)your/Timeline

—— e — —

1. Scene 1 ‘ 2. Scene 2 ‘ 3. Scene 3 ‘ 4. Scene 1 5. Scene 2

6. Scene 3 7. Scene 1 ‘ 8. Scene 2 ‘ 9. Scene 3 ‘ 10. Scene 1 ‘
11. Scene 2 ‘ 12. Scene 3 ‘ 13. Scene 1 ‘ 14. Scene 2 ‘ 15. Scene 3 ‘

\These,are Sequelh

Segments;are,colored\tomatch;Sequences

‘These,are;Segments

\

Set Default Slide Size x * Display sequence description

Segments
A Act1 Act2 k Act3 k Act4 A Act5
i =2 s <

You can drag and drop Sequences on the Timeline canvas to reorder your Timeline.

To dig down deeper to the next level, click on the three dots on a Sequence card.
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@ StoryOo File Help PO S O 3 @MF 0 8% Thul

Timeline

(ClickingjthelthreeldotslonlalSequencelcard]
ey caTanionaTior e S canen

X
Edit Sequence
Manage Index Cards
Delete Sequence

fTolcreatellndex{Cards for thisiSequence]
(thelnextilevel)clickihere]

To modify the Sequence name, click on the Edit Sequence button.

To edit the Index Card (and add info to it), click on the Edit button on that Index Card.

@ StoryO File IndexCard Edit Help @ PO S O 3 MF < 8s%@ Thui2:17
meline E
< My New Project
[ JOX ) Index Cards
W& My New Project > Act 1> Scene 1
1. Scene 1
1. Enter Title 2. Enter Title 3. Enter Title 4. Enter Title
- |
6. Scene 3
Edit Edit Edit Edit
) \
11. Scene 2 .
\These are/IndexiCards for;,the,Sequence:Scene;l
-
\To,edit:an|Index(Card, clickion\the Editbutton,on,that,card
e
407
+ B c Set Default Slide Size Leon

To add more Index Cards, click on the plus button on the bottom left-hand side of the screen.
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A Sequence can have many Index Cards.
So, the hierarchy of your Timeline looks like this:

- Segment
- Sequence
- Index Card

For a screenplay format, this could be:

- Act
- Scene
- Details of Scene

® StoryO File Edit Format Help

OHOO S D 3 @MF < &7%@ Thut2

< My New Project

My New Project > Act 1> Scene 1
-
1.Sc
1. Enter Title D l 2. Enter Title | ] 3. Enter Title | I 4. Enter Title | |
ndox oo @ Edit Card
| My New Project > Act 1> Scene 1 > Enter Title
6. Sc . Description Characters Picture Back of Card
. Enter Title
| Here you can enter information for this Index Card...
1.8
You,can aIsernter‘Characters,(add \aPicture, and enter;
- H ‘ of. D
info,on the <back:of;the,card”here
_| -
E ) description
Segments |
e B E R
- =3

You can move an Index Card from one Sequence to another.
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! 000 : Edit Card
7 Shakespe
's Hamlet > Act One > Scene | > Card Title

i Description Characters Picture Back of Card
i

1. Thy
o ||| G . Card Title

?fa"n‘;’: The ghost materializes for a second time, and Horatio tries to speak to it. The ghost remains silent, however, and disappears again just as the cock A
'l crows at the first hint of dawn. Horatio suggests that they tell Prince Hamlet, the dead king’s son, about the apparition. He believes that though the

- ghost did not speak to him, if it is really the ghost of King Hamlet, it will not refuse to speak to his beloved son.

5. Cal
o The ght

and Hot

remains

again Ju
1
r -
I - H \

\ \ Y,
To,move,this,card to,anotherSequence,
A N A v

i click.this button on the Index.Card
L

You can also add Characters to Index Cards.

Go to the Index Card and click on the Characters tab.

Then click the Add Characters button.
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lndav Oarda

[ J Edit Card

E Shakespeare’s Hamlet > Act Two > Scene | > Card Title

= Description Characters Picture Back of Card

I.Q

ool . Card Title

‘eyn

vritte

im¢
Polonius o

B Reynaldo n
Ophelia Lead n

‘Toadd Characters;toan Index:Card, click-here
Total Characters: 3
E ML 2~ 0

Creating Characters

To create characters for your project, click on the Character button from the Timeline screen.
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@ StoryO File Timeline Edit Format

Extras

Help

OHOOS H 2 WEF

84%

Thu 12:

{ Shakespeare’s Hamlet

Timeline

1. Scene |
The Ghost of King Hamlet appears.

2. Scene Il

Hamlet laments his father's death.

‘ 3. Scene llI

Polonius speaks with Laertes before
he leaves to France.
. eoe

4. Scene IV
Hamlet waits for this father’s ghost.

5. Scene V

The ghost tells Hamlet he was
murdered by Claudius and to

6. Scene | 7. Scene Il ‘ 8. Scene | ‘ 9. Scene Il ‘ 10. Scene Il
Ophelia tells Polonius that Hamlet Politics with the Danes and “To Be Or Not To Be" speech. The play for the king. Claudius guilt and Hamlet's first
accosted her. Hamlet's mad love with Ophelia. attempt at revenge is foiled.
eee oo .ee eee eoe
11. Scene IV ‘ 12. Scene | 13. Scene Il 14. Scene lll 15. Scene IV
Hamlet kills Polonius. Gertrude tells Claudius that Hamlet Rosencrantz and Guildenstern Hamlet tells Claudius that Polonius Hamlet meets Fortinbras.
is mad. is dead. The King sends Hamlet to
eoe eoe eoe .ee .o
16. Scene V 17. Scene VI 18. Scene VII 19. Scene | ‘ 20. Scene Il ‘
Ophelia goes mad. Hamlet returns to Denmark. Ophelia drowns in the river. Funeral procession in the The duel with Laertes and the death
graveyard. of Claudius and Gertrude.
.o eoe eoe eoe cee
Clickion,the,Character,button to,create ,Characters
)
Set Default Slide Size x " Display sequence description
Segments
Act One Act Ty Act Three Act Four Act Five
A A A A

Fi L EAR S

This will take you to screen that lists all your Characters.
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[ StoryO File Characters Edit Format Spelling Extras Help @ -rJ-} @ @ S 9 % @ F « 83% @) Thul2
< Shakespeare’s Hamlet @ o @ P
Shakespeare’s Hamlet
J Mo_.;.], Character Name CharacterType Casting Type Age Range
Hamlet o Lead
1. Scene | i Claudius
The Ghost of King Hamlet appears. Gertrade
Polonius .
2 o List,ofCharacters
6. Scene | ! Ophelia ... Toedit;aCharacter;andall details;about;that:
Opheliatels Polonius that Hamet Laertes Character, clicksthe,three dots...
accosted her. Fortinbras eoe
1 The Ghost
Rosencrantz
. Soe.ne v ‘ Guildenstern
Hamlet kils Polonius. Ostic
Voltimand
| Cornelius
16. Scene V 1 Marcellus
Ophelia goes mad. Bernado
Fernando
Reynaldo
Francisco
Create,a new\Character, =
Display sequence description
Segments | E
T L
A
T E=aBR S « >

You can enter background, youth, profession, religious beliefs, and much more about each
character.

There is also a Goals tab, where you can specify detailed goals for each character, and track
their growth or fall throughout the story.

The Outline

The Outline module allows you to answer crucial story and plot point questions about your
project.

10
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@ StoryO File Edit Format Spelling Extras Help @ PO S O 3 MF 0 79%@ Thul2:
I
< Time Travel -
o0 e Outline
Time Travel

d Theme Problem Plot Points One Line Sub Plot Message

1. Bill at School ‘ 2
What is the theme of the story?
Bill gets into trouble. H
P The theme of the story is... ~
eoe )

1
6. Welcome to 1779 ‘ 7
The boys meet Nappy B

w
)

B r
11. Meet Julius Caesar ‘ 1
Bill and Alex meet Caesar.

- v

What is the thematic conflict in the story?

Click:here to,access the Qutline module,
\where )youcan answer:questions,about:your;project:

= | | —
o | O
E:z. x * Display sequence description
Segments
A Current Year kJu i lod Civil War The French Revo... kOmW.*B.bn kmwnw.n Roman Times kmnm
+3 =2 B < 2
Printing Reports

StoryO has many reports that you can print.
Select the Print button on the bottom of the screen, then select a Module and then a Report.

You can also Sample a report, by selecting the report and then clicking the Sample button.

11
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@ Story0  Help O PO S DO 3 @A 0 7%@E Thul

Timeline

< Time Travel

1. Bill at School ‘ 2. Bill meets Abe Lin... 3. Next School Day ‘ 4. Bill and Alex meet ... ‘ 5. Carrie’s Boyfriend ‘
Bill gets into trouble. Helps sign the Emancipation Bill Meets Carrie Bill goes back in time to see Big Mean Buddy
Proclamation. dinosaurs.
eoe see Il eee Il eee Il eoe
i x B
6. Welcome to 1779 ‘ 7. Tricking Bud Select a Module: Select a Report: The Gunfight ‘
The boys meet Nappy Bill and Alex travel Project Segments [with Sequences] and Alex wear cowboy boots.
week. " "
. /' Timeline Segments [Outline Form] .
1 Index Cards Sequences [2-Line Boxes] »

) . Characters Sequences [Full Description]
11. Meet Julius Caesar 12. The King a1

Bill and Alex meet Caesar.

How to save to PDF

Sample Preview Print

Clickithe Print button\to,access the Reports module

)

Set Default Slide Size x " Display sequence description

Segments

A Current Year A Jurassic Period War kThs French Revo... LOrw Week Before A The Wild West A Roman Times kMedieval Times m
+tiL O =2 . <=2

Exporting your Project

To access export options for your project, select the File pull-down menu and then select the
Export option.

[ —— | .
[N ) | Close BW | Timeline

i Save Project... S H
< Time ™ Pri\:: rojec o Export Options for.your;project:

™ A, Lt

Index Cards to Text

Timeline to Text
1. Bill at School 2.E Outline dext School Day ‘ 4.
Bill gets into trouble. :::l: Scheduling to Gorilla Meets Carrie 2:::
eoe Scheduling to Chimpanzee oo
1 Screenplay > B
6. Welcome to 1779 ‘ 7. Tricking Buddy vfe. Freeing Buddy ‘ 9.
The boys meet Nappy Bill and Alex travel back in time one Bill
week.

11. Meet Julius Caesar ‘ 12. The King and his d... ‘ 13. Trouble with Parents ‘
Bill and Alex meet Caesar. Getting suspicious

12
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Exporting to the iOS version of StoryO

Select the three dots next to the name of the project you want to export to the iOS
version of StoryOQ, then select the Export to iOS button.

‘e0 @ Projects
.
Story, @)
% Shakespeare's Hamlet ~

Stage Play

The play, set in Denmark, recounts how Prince Hamlet exacts revenge on his
uncle Claudius, who has murdered Hamlet's father, the King, and then taken
the throne and married Gertrude, Hamlet's mother.

ofStoryQ, click:here
Time Trave

Short Story

X Time Travel
This is a sample project file to show how the Timeline W
Edit Details

Save to Default
Save to Documents

Save to Dropbox
Export to iOS

Delete Project

Note that the iOS version of StoryO, does not import your Characters or your Outline.
It exports the Timeline, including Segments, Sequences, and Index Cards.

Importing an iOS file into StoryO 3
To import an iOS StoryO file, you must first export the project from your iOS app.
Then select the i0S button (bottom left) on the Projects screen.

If you need more help, check out our free Training Videos on our site, or e-mail us at:
support@junglesoftware.com.
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